DiCentra Release Notes
For Release 3.16.179

Changes and Bug Fix in Release 3.16.179
Marks can be included in extracted image filenames
- An option has been added to the Extract Images… command on the Competition menu that includes the mark scored in the filename of extracted images.
- Any unmarked images will show the marks component as ‘(-)’
- This works for the following marking schemes: Marks, Triple Judge and Place marking.
- You may find it useful when extracting all competition images at the end of the season for storage elsewhere.

‘Disk Full’ when extracting or exporting to memory stick
- On rare occasions DiCentra would erroneously report a memory stick was full when exporting a competition or extracting images from a competition.
- This was caused, in part, by Windows flagging folders and their contents in .zip files from Macs as Encrypted.
- DiCentra now handles such ‘encrypted’ files appropriately.

Fix to licence installation code
- When a licence image had already been installed, but only the licence key needed to be replaced the licence installation was not performed correctly.
- This has now been fixed.

Changes and Bug Fixes in Release 3.15.176
Sequence Editor
- A number of improvements have been made to the sequence editor. It is now possible to select all images and make a sequence from them without having to select each image in turn.
- It is also possible to sort the selected images by image number, author name (including likely surname) and by marks scored.
- The user interface has been made slightly less irritating.

Randomisation
- An additional form of randomisation is now available for competitions other than Portfolio competitions. All Images randomises the whole competition over all the images. This may result in several images from an entrant appearing in close succession, rather than spaced out as with the other schemes.
- It is also possible to randomise the order of the set of images selected with the Navigator. There is a check box to do this. It may be useful for knock-out competitions to randomise the remaining images after each round.

Ranking of Scores
- Under some circumstances the ranking of entrants’ scores that differed by ½ mark was incorrect. This has been fixed.

Lightbox Thumbnail Clipping
- In some circumstances (Windows XP?) the Lightbox window size was smaller than it should have been, and also the thumbnails were clipped slightly at their right and bottom edges. This has now been fixed.
Blank Scoresheet Heading
- The words “Round N” in the blank score sheet wrapped on to two lines because the indent was not set to zero. This has been fixed.

Changes in Release 3.14.173
Knock-Out Competitions
- A number of clubs have been successfully using DiCentra for knock-out competitions where pairs of images are judged against each other and the weaker image is given a mark, until only the winning image remains.
- Some clubs prefer the pairs of images to be presented and marked side-by-side, albeit at a smaller size.
- This is now possible by flagging the competition as a knock-out in the DiCentra Rules. The Lightbox is then used to compare the pairs of images followed by the Navigator to select unmarked images for the next round.
- Further information can be found in the DiCentra Tutorials installed with the application (Help > DiCentra Tutorials).

Licence Image
- In earlier versions of DiCentra it was impossible to install a new licence image if the original image was faulty.
- This problem has now been fixed, but please note that such images and the corresponding licence key need to be generated by Wilbur Imaging.

Bug Fix in Release 3.14.170
Extracting Images for Slide show/Photo frame
- If a large number of images were extracted to a slide show an error could result and the tail end of the slide show would not be generated.
- This has now been fixed.

Changes and Bug Fixes in Release 3.14.169
Marking in Lightbox
- It is now possible to mark, add awards and hold back images for competitions in the Lightbox.
- Triple-judge competitions can have marks or votes added in the Lightbox, but voting mode must be selected before using the Lightbox (right-click in full-screen competition mode).
- Multi-judge marking, where marks from several judges are entered separately, is not allowed in the Lightbox.

Hiding Marks and Awards
- If a competition has been pre-marked, there is now an option displayed when you run it, allowing you to hide marks and awards.
- When this is selected, no marks, awards or held indications will be shown on the full-screen display or in the Lightbox.
- During the competition, you can reveal all the marks, awards and held indications by right-clicking on the full-screen display and selecting Show Marks and Awards.
- While marks are hidden, you cannot enter or delete marks or awards or change held status.

MiCentra Support
- Free software, called MiCentra, which will help entrants generate correct entries, will be available shortly.
A new tab is now available in the Rules editor to allow you to enter the competition organiser’s details.

There is no compulsion to fill in this information, but it may be helpful to entrants.

**Image Profiles**

- DiCentra 3 does not support ICC Version 4 profiles for the image colour space and would fail when it encountered one.
- Changes have been made to detect such profiles and report them as an error, rather than crashing.
- In such cases, the original image colour space should be converted to Adobe RGB or sRGB (ICC Version 2 profile) using Photoshop or a similar application and then the image should be re-loaded.

**Image Metadata**

- On Vista and Windows XP, Windows library code very occasionally fails to properly deal with the image’s metadata. In previous versions, this caused an unexpected error.
- A warning is now added to the log in such cases, indicating that the original metadata has not been copied. This makes no difference whatsoever to running the competition. However, it does mean that such images will be stripped of the copyright information in their metadata.

**Streamlined Image Loading**

- When loading images, a number of (annoying) dialogues may appear.
- There is a new *Preferences* option to reduce this. Select ‘*Don’t ask for confirmation when entrant’s images are reloaded*’ on the *General* tab in *Preferences* to avoid having to confirm that you want to replace an entrant’s images when re-loading.
- If you use *Organiser* to create a folder of entrant’s image folders, or you put your entrants’ folders into a master folder on the hard drive before loading, just select the master folder when asked to select a folder during *Load Entry*. All the sub-folders will then be loaded with a few less clicks.
- The old way of selecting folders for loading is still available. Just select one of the entrants’ folders (instead of the master folder).

**Bug Fix in Releases 3.13.158 to 3.13.160**

**Spreadsheet Merging**

- When the results for a set of competitions were merged, the results for entrants who only intermittently entered were sometimes in the wrong columns. This has been fixed.

**Competition Names**

- An unexpected error occurred when loading images to a competition whose name contained a ‘.’ character. This has been fixed.
- Any legal filename should be usable as a competition name. Previous versions of DiCentra did not allow all possible legal names. This has been fixed.

**Reports**

- Characters such as £, ¬, { and } were not showing correctly in reports. This has been fixed.

**Changes and Bug Fixes in Release 3.13.155**

**Flipping Between Main Image and Lightbox**

- Towards the end of a competition it can be useful to select high scoring images for consideration for awards, and the Navigator and Lightbox provide a quick way of identifying these candidates. In the past, if the judge wanted to see an image full-
screen it was tedious (using the Navigator) to display the candidates on the Lightbox again.

- The $F3$ function key can now be used to re-select the last selection made in the Navigator and show those images in the Lightbox with just a single keystroke. Double-clicking an image in the Lightbox brings it up full screen.
- Note: The $X$ command provides similar functionality for held images without using the Navigator.

**Annotated Images for Digital Photo Frames or Slide Shows**

- Digital photo frames of a suitable size are ideal for showing slide shows of selected images at exhibitions, but they need to have the title, photographer and any award details.
- The *Competition > Extract Images* command in *DiCentra* now produces an additional folder called *Slide Show* which contains the extracted images together with these details superimposed on the image.
- At present, there are no options – the font size, colour, image size etc are all fixed. All images are produced the same size as the original competition maximum image size and any unused area is filled with black.

**Rules Change**

- It is now possible to reject images where their size or colour space or both do not match the rules.

**Triple Judge Competitions**

- It is now possible to select those images that score a ‘5’ excluding any that have marks between 13 and 15.

**Cancel Multi-Entrant Loading**

- When loading many entrants at a time it was impossible to abort the process other than by aborting *DiCentra*.
- It is now possible to cancel the operation at the end of loading an entrant’s images whether or not the *Pause …* option has been chosen.

**Bug Fixes**

- Changing an image’s held status in the Lightbox now clears the Held images palette at the bottom of the screen. Similar problems elsewhere have also been fixed.
- Where the rules of an inter-club competition do not need an author, loading images no longer produces an unnecessary warning.
- Using *Help > Release Notes* no longer gives errors after a report has been produced.
- It was possible to award a ‘5’ with a mark below 9 in triple judge competitions. This has been fixed.
- It was possible for an image to be given a mark below its lower limit, for example if a digit had been missed off. If this is detected when you move to another image a warning message will be displayed.
- If you wish to change the existing mark when you return to an image, you will need to delete the old mark first (with the delete key).

**Bug Fix in Release 3.12.151**

**Print List Processing**

- If a print list contained spurious end-of-line characters (e.g. inserted unintentionally via some applications) an unexpected error would occur while the Status Log was being updated. This has now been fixed.
- The Status Log now shows ‘** Blank Title **’ if no title was provided.
**Changes in Release 3.12.150**

**New Tutorials**
- A set of tutorial notes are now available. These are task-oriented, and cover many of the common procedures that competition organisers need. I hope you find it useful.
- Both the tutorials and the User Guide R3 are now available from the DiCentra Help menu. Just click, and provided you have an application set up on your machine that can read PDF documents, the relevant document will open.

**Extract Images**
- You no longer need to include image numbers when using *Competition > Extract Images*.

**Colour Management**
- Under rare circumstances, tables in the device adaptor for the monitor/projector were not restored correctly on exit from *DiCentra*. This has now been fixed.
- Any colour space profile in an image that contains ‘sRGB’ somewhere in its name is now assumed to be an sRGB profile and the image will not be transformed or rejected when it is first loaded.
- The Windows sRGB profile now appears in the list of available projector profiles for those who find it useful.

**Thumbnails**
- It is now possible to choose the thumbnail size you would like in the *Lightbox* and the *Held back dialogue*. This should be useful for those with large format projectors.
- Note 1: The size of these thumbnails is still fixed during a competition (sorry!).

**Backward Incompatibilities**
- Please note that competitions prepared with more recent versions of *DiCentra* than 3.8 must have at least *DiCentra 3.10* on the machine running the competition, otherwise you will get error messages when you hold back images during a competition.
- If you want to use the larger thumbnail feature you must have *DiCentra 3.12* (or later) running on both the machine used for preparing the competition and the one for running it.

**DiCentra Cropper**
- A free applet, *DiCentra Cropper*, is now available on the *DiCentra web site*. It is intended for those who want to use *DiCentra* to run print competitions and include photos of the prints.
- *DiCentra Cropper* takes a folder of images from your camera and, based on the corner points you identify, it rotates and crops the photo. You can also adjust the tone using features similar to the *Levels* control found in many imaging applications.

**Changes in Release 3.11.147**

**Managing Print Competitions**
- It is now possible to create a competition for prints with either placeholder images containing just the print title or photographs of the prints. A text file needs to be prepared which contains the print details, similar to the folder and filename fields in the rules. Full details are contained in the *Print Competitions* section in Chapter 4 of the User Guide R3.
Caption Fixed

- The caption for the results marks has been changed to indicate that unmarked images with awards are also included.

Backward Incompatibility

- The internal filename changes in DiCentra Release 3.10.144 cause a problem when a competition created with 3.10.144 or later is run with an earlier version of DiCentra and an image is held back.
- When you upgrade to version 3.10.144 or later, please ensure that all your machines running DiCentra are updated together to avoid such problems.

Changes and Fixes in Release 3.10.144

Maximum Marks

- The maximum marks that can be set in the rules for a competition has been increased to 150.

Long Filenames

- DiCentra would very occasionally report an unexpected ‘File name too long’ error when making competitions or importing them. The filenames used internally within DiCentra have been shortened, so that this problem should almost never arise in future.
- It is always a wise precaution to import a competition to the machine running the competition beforehand and to run through a slide show to ensure that all images have been correctly copied.

Merging Competition Sequences

- There is a new Setup > Load Sequence command. This allows a new competition to be made from sequences of images created in compatible competitions.
- For example, if you wanted judges to make awards to the best images from competitions for Portraits, Nature and Pictorial you could create a sequence in each competition for the images with top marks using the Navigator and then use Setup > Load Sequence to build a competition from these images.
- It also allows inter-club play-offs to be created by creating sequences of the leading clubs images in each round.
- See Merging Images from Competitions in Chapter 4 of the User Guide for further details.

Changes and Fixes in Release 3.8.139

Preferences

- It is now possible to suppress the display of image numbers during a competition using the Image Details tab in Edit > Preferences.
- DiCentra would crash if Background Image was set on the Title tab but no image was chosen. You are now required to select an image before you are allowed to save the preferences if you select Background Image.

All-Comers Comps

- A bug caused All-Comers rules to revert to club comps sometimes during editing. This resulted in the loss of club details when the competition was generated. This has been fixed.
- It is now possible to use the Navigator to select all entries from a given club in All-comers comps using sequences that are automatically generated for each club. This is in addition to selection of entrants by their name.

Large Inter-Club Comps

- These comps now accept reference codes that begin with either letters or digits and may contain a mixture of the two.
Loading Images

- Large sequence numbers are now acceptable again. This fixes a restriction introduced in version 3.8.131. (Some clubs use this to encode the sequence number and an entrant code.)

- Underscores in titles could result in incorrect parsing of file names. When such file names are found during loading now, the information is presented to you to manually sort it.

- In rare cases the order in which images were loaded was not in ascending file name order. This has been fixed. So, if images have a sequence number at the start of the file name, image ‘1 Moonlight.jpg’ will be processed during loading before ‘4 Sunset.jpg’. Note that ‘04 Sunset.jpg’ will still be loaded before ‘1 Moonlight.jpg’ so ensure that all images have the same number of digits in their sequence number.

- Previously, an 8-bit monochrome image that had an sRGB profile would cause DiCentra to crash when an attempt was made to display the image in the competition. DiCentra now rejects such improper image files during loading.

Spreadsheets

- Spreadsheets could not be input to Excel 97 and in Open Office showed a few garbage characters at the start. An option is now available to output spreadsheets as ASCII for such cases only. Note that the ½ symbol is replaced by ‘?’ when this is used.

- When spreadsheets were merged to accumulate the results of several competitions, the columns could be misaligned if an entrant was not included in an earlier competition. This has been fixed.

Changes and Fixes in Release 3.8.131

- If the # character is used in folder names to include a comment and there is a dot immediately before it, then DiCentra erroneously reported that a .wie file had been loaded. This has now been corrected.

- For competitions where a sequence number is expected at the start of image file names, DiCentra could hang if this is missing and the image title started with a large number, e.g. “77777 trombones.jpg”. This has been fixed.

- The dialogue for editing image filenames that do not match the expected format has been improved to reduce re-typing.

- Function key F2 can now be used to alternately start a slide show from the beginning or stop it.

- If places were added as awards in place-marked competitions the results were not shown in the correct order. This has been fixed.

- Fonts for text displayed during a competition are now scaled to avoid layout problems when Windows is configured with font scaling of more than 100%.

Fixes in Release 3.8.126

- When creating new rules, surplus spaces in the competition name would cause an error report to be produced. This has been fixed.

- Under some circumstances the sRGB profile, and possibly others, did not show in the drop-down list of available profiles on the main DiCentra screen. This has been fixed.

New Features and Fixes in Release 3.8.125

- PageDown and PageUp can now be used to move forward and back through images. This is useful for some hand-held presenter devices.

- Folders on CDs that have a blank at the end of their name caused an error during loading. (Windows won’t allow them to be copied either.) A message is now displayed indicating how to recover such folders.
Windows 7 sometimes changes the name of an image’s Adobe RGB colour space to opRGB. DiCentra now handles this without comment if the competition colour space is Adobe RGB. Adobe RGB variants, such as ‘Epson Adobe RGB’ are also accepted.

The status panel is minimised once the competition is made. It can be expanded manually.

New awards have been added for Very Highly Commended, Highly Commended, Commended, Best in Exhibition and Judge’s Choice. See the User Guide p. 56 for normal keyboard commands and p. 43 for Lightbox commands.

The Lightbox now allows sorting by Award or Award Reversed.

The Held status of images can be changed in the Lightbox.

New Fix in Release 3.7.121

Some entries were not printed at a page break when the Blank Scoresheet was printed from Wordpad. This has been fixed.

New Fix in Release 3.7.119

On some Windows 7 machines colour management was not restored correctly when DiCentra closed. This has been fixed.

New Features and Fixes in Release 3.7.117

A ‘Save’ button has been added to the Navigator to ease the process of saving selections as sequences, and adding or removing sets of images from sequences.

For inter-club competitions using ‘by’ as a separator, all capitalisations of the word are now accepted.

When you run a competition, back-arrow now allows stepping from the competition banner page to the last image. This also works when a sequence, such as held images, is being shown.

A problem with rules editor apparently reverting to include a reference number in Large Interclub competitions has been fixed.

A problem with unreadable rules files has been fixed. It occurred with competition dates greater than 12th of the month on machines with different regional settings to the machine on which the rules had been created.

The range of display/projector sizes in rules and preferences has been expanded.

New Fixes in Release 3.6.114

When making interclub comps and some clubs had too few entries, a dialogue was presented with no OK button. This has been fixed.

On some systems the Load Entry progress bar could get hidden behind the main DiCentra window. This has been fixed.

Closing DiCentra when it was apparently stuck could cause Log files to remain locked. This has been fixed.

On some systems there were reports of DiCentra reporting it was unable to read certain rules files on startup or after importing them. It is now less sensitive to certain variations in Rules files.

An extra field ‘ESeq’ has been added to spreadsheet reports. This is the entrant’s number for the image (in the range 1 to max. images per person or per club).

New Fixes in Release 3.6.112

Spreadsheet reports by author can now be generated for All-Comers competitions. The results for all images by a given author are contained in one row of the .csv file.
It is now possible to export and import results-only. This can be useful after a competition when exporting the results back to a desktop/master machine.

A “x:\ Disk full” message was erroneously produced when a file with a long name was imported or exported. A more informative message has been added.

Note: The full names of files will change slightly when a competition is moved between machines. Occasionally this results in their length becoming greater than the Windows limit of 256 characters. If an error message occurs, try re-importing just the rules and competition. If this is still not successful you will need to go back to the original images or folders and shorten the offending names before exporting again.

New Fixes in Release 3.6.111

- Typing the ‘c’ command in a competition to clear all held images now asks for confirmation
- The Light Box can now be used for marking place-marked competitions. Just select a thumbnail and type its position (1-9) or 0 to clear its place
- This change means that the Arrange > By Place and Arrange > By Place Reversed context menu commands now work for these competitions
- A bug with ordering of place-marked competitions in the scoresheet has been fixed
- Titles that include curly brackets no longer cause problems with printable reports
- A sequence “No Titles” is now generated automatically for portfolio competitions for those who do not want title images to be seen

New Fixes in Release 3.6.108

- Fixes problems with renaming and deleting entrants in competitions with entry numbers
- Importing ‘Rules and Competition Only’ fixed to leave log information undisturbed
- Fixed problem with losing last character before # in folder names
- Fixed to replace illegal filename characters by tilde (~)
- Fixed to remove error when importing ‘Rules Only’ if there is no Assembly Area folder in the same folder
- Added progress bar to indicate progress while making large competitions
- Fixed unexpected error that occurred at the end of making a Multi-Judge type competition

New Fixes in Release 3.6.105

- Fixes a problem where rules that do not use sequence numbers appear to revert to having a sequence number if they are re-opened with File > Open Rules.

New Fixes in Release 3.6.104

- Fixes a problem with selecting a club in the navigator for large inter-club competitions.

New Fixes in Release 3.6.103

- Contains an assortment of small bug fixes

New Fixes in Release 3.6.102

- The short-hand marks entry for triple judge competitions has been fixed so that it now works as before.
- The image number qualifier (Exactly, Maximum, Unlimited) for large inter-club competitions did not always show the correct setting. This has been fixed.
**New Fix in Release 3.6.101**
- Under certain circumstances the first filename component specified in a competition’s rules could get reset to ‘Sequence Number’ or ‘Reference Number’ after the rules had been saved. This has been fixed.
- The ‘Don’t split into rounds’ option for score sheets has been fixed.

**New Features and Fixes in Release 3.6.99**
- A new tie-break mechanism has been added for inter-club competitions. An extra image from each club involved is ranked if a tie occurs. Inter-club competitions that use this mechanism must have a sequence number for each image and the final one is taken to be the tie-break image.
- A new ‘Large Interclub Competition’ type has been introduced. This allows for interclub competitions that do not have affixed number of entries per club and where images may be identified by a reference number.
- You can now access the DiCentra web page from the help menu and check to see if you have the latest version if your machine has an internet connection.
- Options allow blank score sheets to be produced for judges without information identifying clubs or entrants.
- Users of the trial version can now access all DiCentra features except projector setup, but are limited to a maximum of 3 entrants and a maximum of 3 images per entrant.
- A rare problem that caused a crash during a competition has been fixed. This problem only occurred rarely, and only with monochrome images.
- A rare crash on Vista machines when DiCentra starts has been fixed.

**New Fixes in Release 3.5.92**
- A text box that obscured part of competition images has been suppressed.

**New Fixes in Release 3.5.91**
- A problem that caused DiCentra to produce an error at start-up on machines where the system drive was not C: has been fixed.
- A problem where (very rare) images caused a crash during a competition has been fixed.

**New Fixes in Release 3.5.88**
- A problem that caused DiCentra to produce an error (and display an elephant) instead of the title slides for portfolio competitions has been fixed.

**New Fixes in Release 3.5.87**
- The progress bar that shows when images are being loaded should no longer obscure other dialogues.
- There is a new shortcut to start a complete slide show: <F2> – function key 2.
- The separator between image number and title in portfolio image names can now be chosen from the usual range, including underscore.
- 1050 x 1050 pixels is now an allowable image size.

**New Fixes in Release 3.5.86**
- A bug which caused DiCentra to crash when used in try-out mode has been fixed.
When All-comers competitions are made, the dialogue to choose the number of entries accepted is now of fixed size to prevent the OK button disappearing off the screen.

Some entrants accidentally include a dot at the start of an image’s title or include underscores instead of spaces. These are now cleaned up automatically.

New Fixes in Release 3.5.85

Miscellaneous
- The limit of 50 images per club for inter-club competitions has been removed.
- A progress bar is now shown while images are being loaded.
- A new shortcut key (‘x’) can be used to switch to the lightbox to review held back images. This can also be accessed from the Show Held Images on Lightbox item on the context menu.
- The <down-arrow> key can be used as a shortcut to view all held images. They can then be stepped through using the right- and left-arrow keys.

Colour Management
- All installed display/projector profiles are now displayed in the profile selector.
- A bug in applying the selected profile has been fixed.

Awards
- New awards have been added for 1st, 2nd, 3rd and 4th place as well as Hon. Mention.
- Awards are now added to images using <Alt>+code, for example, <Alt>+1 for 1st place, <Alt>+g for Gold Medal etc. Note: When an award is added to a selected image in the lightbox there is a beep when the <Alt> key is pressed. The award is correctly changed, though.
- The old shortcut keys for awards still work.

New Fixes in Release 3.5.79

Titles Properly Suppressed between Images
- If DiCentra’s Preferences were set to hide the image’s title initially when the competition is run, the title could momentarily appear if you moved to the next image while the marks and title for the previous image were being displayed. This has been fixed.

Adobe RGB Warnings Added
- If you set the rules for a competition to expect images in Adobe RGB (1998) working space, DiCentra will probably need to find that profile on the machine that you use to load and make the competition. This is so it can correct any images that have the wrong working space. If no Adobe software had been installed on this machine, previous versions of DiCentra crashed when an image needed conversion. It now warns you of the potential problem, if appropriate, and politely abandons conversion of incorrect images.
- Once the profile has been installed there will be no conversion problems.

Sequence Numbers No Longer Needed
- For club competitions and inter-club competitions, sequence numbers no longer need to be included in the image file names, so in the simplest case they might just consist of the image title (plus file extension).
- The default filename template in the Rules dialogue still includes the sequence number, so you will need to explicitly change the filename components if you want to use this arrangement.
Portfolio competitions still require sequence numbers in order to present the portfolio in the correct order. All-comers competitions need them in case only a limited number of images from each entrant are used, so the entrant can indicate their order of preference.

**New Features in Release 3.5.76**

**Multi-judge Support added**

- Support for competitions using a judging machine with three judges has been in DiCentra for over a year. This new form of marking scheme allows between 2 and 5 judges to select images and then jointly mark the selected images. An application note is available on request.

**Easy Creation of Sequence of Held Images**

- When running a competition, there is now an item on the context menu (right-click anywhere on screen) to allow saving held back images as a sequence called Selected. This can be useful for extracting images, or producing reports of the top images.

**New Fix in Release 3.4.70**

**Artefacts in Image Details removed**

- If image details were suppressed when an image was first displayed, then when the mark was entered the details of the previous image were momentarily displayed. This was most noticeable for competitions with a large number of images. This has now been fixed.

**New Fixes in Release 3.4.69**

**All-Comers Competitions**

- If club names were included in all-comers competitions they did not get displayed on the printable results, nor were they included in any spreadsheet. This has been fixed.

**Licence Terms**

- Section 2.1 of the licence terms could be interpreted narrowly to mean that DiCentra is only licensed on one machine per licensed organisation. This is not the intention, so the wording has been changed to specify 'no more than 5 machines' per organisation for the code.

**New Fixes in Release 3.4.68**

**Certificates in Navigator**

- If Certificates were added in the Lightbox, the Certificates option in the Navigator was not enabled. This has been fixed.

**Download Size**

- DiCentra’s download size has been reduced to about 7Mbytes.

**Miscellaneous**

- ‘&’ character in image titles now displays correctly in the on-screen image details.
- The Import/Export progress bar sometimes appeared to stall, even though copying was still taking place. This has been fixed.

**New Features in Release 3.4.64**

**Entry Number**

- Entry numbers can now be associated with each entrant’s images. It needs the new Comp. has Entry Numbers check box to be ticked when the rules are created. Then, when each entrant’s images are loaded you will be asked to type in their
entry number. The on-screen scoreboard and printable results can be sorted by
entry number (default) or by author name. The spreadsheet results contain the
entry number as well as the usual information.

Portfolios
- ‘Portfolio’ competitions can now be run with DiCentra. These are where an entrant
will submit one or more portfolios of images each in a separate folder. Each image
can be marked individually and/or the portfolio can be marked as a whole.

Reversed Names
- For competitions, other than portfolio competitions, entrant names can be specified
to be surname first, e.g. ‘Smith, Joshua T, ARPS, CPAGB’. Either comma or
underscore can be used as separators between the surname, forenames and
distinctions so the previous example could also be: ‘Smith_Joshua T_ ARPS,
CPAGB’.
- In general, this feature makes little difference to competitions other than names
being easier to find in alphabetic name lists. It also allows the surname, forenames
and distinctions fields are correctly produced in the spreadsheet reports.
- When combined with the entry number feature above, reports can be sorted by
entry number or by surname.

Option to Suppress Marks in Printed Results
- Some organisations want to suppress marks on their published reports, although
marks are still needed during selection or judging. This is now possible.

New Fixes in Release 3.3.54
Installation on Vista
- After installing a licence on Vista an error message occurred whenever DiCentra
was run. Even if you were using an administrative account, this indicated that you
should run DiCentra once from an administrative account and then it closed the
application. This has been fixed.

New Fixes in Release 3.3.53
Load Entries
- Some images (possible created with ACD software) caused DiCentra to report an
unexpected error. This has now been fixed.

Non-Admin Accounts
- Running DiCentra from a windows account without Administrator privileges caused
it to crash. This has been fixed.

New Features and Fixes Release 3.3.51
Export/Import
- It is now possible to export and import only those files needed for a competition.
This can significantly reduce the file space needed and the transfer time. See User
Guide for details.

Extracting Images
- It is now possible to extract all or just a sequence of images and thumbnails from a
competition (Competition > Extract). This can be useful for sending to the judge
beforehand, providing a handful of images at the start of a competition for
normalisation of judging, or for extracting images and thumbnails for building a web

Sequence Creation and Editing
- Sequences can now be built manually (Competition > Edit Sequence) as an
alternative to using the Lightbox. They can also be edited. This is useful in
connection with the Extract function and also for selective report generation. See User Guide for details.

**Licensing**
- Problems when running *DiCentra* on Windows user accounts without administrator privileges have been fixed.
- When a licence is installed it now covers all Windows accounts on the machine. This also occurs when version 3.3.51 of *DiCentra* is run for the first time.
- Multiple licences can be installed on one machine for cases where it is used by more than one licensed organisation. See User Guide for details.

**New Features and Fixes Release 3.2**

**Rules**
- The marks range for Auto certificates has been extended to include the top 5 marks for the competition.

**Load Entries**
- Cases where the correct working space in some Photoshop CS2 and CS3 JPEGs was not recognised has now been fixed.
- The log now reports the original image size and/or colour space in cases where the image has to be fixed to comply with the rules. It also provides greater detail for some types of unacceptable file formats.
- Images with large (printer) profiles as their working space are now processed correctly.
- The 'Malformed .wie File' error no longer occurs if all of an entrant’s images are skipped or rejected.

**Run Competition**
- Keyboard input now works correctly after the Help panel has been shown and dismissed.
- The display of image details when an image is first shown can be suppressed or enabled during a competition using the ‘D’ command or the ‘Initial Details’ item on the context menu.

**Reports**
- It is now possible to export the results of a competition to a spreadsheet or database for further processing using File > Reports > Spreadsheet Reports. For club competitions results of a series of related competitions can be merged.

**New Features and Fixes Release 3.1**

**Load Entries**
- Non-consecutive sequence numbers in an entrant’s folder no longer cause an unexpected error.
- Large images no longer cause ‘GDII+’ error
- Competitions with images originating from CD can now be deleted.
- When ‘Reject incorrect images’ is selected in the rules, incorrect images no longer give an ‘object reference’ error.

**Run Competition**
- The image details display that appeared when images were first shown can now be suppressed by settings in Preferences.
- Award badges are now included on the image details strip and it has been streamlined. Its opacity can be controlled with Preferences.
- Users can now use their own designs for award badges. See the User Guide for details.
Light box
- Lightbox thumbnails can be sorted by mark – ascending or descending – or by sequence number.
- Awards (but not marks) can be assigned to an image when its thumbnail is selected in the Lightbox.

New Features and Fixes Release 3.0
There have been a number of new features introduced since the Beta versions of DiCentra. The list below includes some older and some new features.

We will continue to review all comments, suggestions and bug reports that you send and will be adding some new features during the coming year.

Main Form
- DiCentra now restricts the features available for the unlicensed trial version.
- You can now select the projector profile directly within DiCentra before running the competition. The original profile is restored when DiCentra is shut down.
- Entrants can be renamed directly by selecting them in the log and clicking ‘Rename’.
- The logo screen now shows your organisation name when a licence is installed.
- The menus have been slightly re-organised and the Settings menu has been removed – it served no real purpose.

Rules
- Competition names can now include arbitrary capitalisation. DiCentra still changes the name to initial capitals when you enter it, but allows you to change capitals afterwards.
- The entry date and competition date fields now work, although only the competition date has any effect. It is displayed in the results report and is used to sort the competition selector on the main form so that old competitions are at the bottom.
- Images of the wrong size or colour space can be converted to the correct size or rejected depending on an option chosen in the rules.
- ‘Places’ and ‘Triple Judge’ marking schemes are included. The first allows images to be marked as 1, 2 or 3 etc. for 1st, 2nd and 3rd place. Triple judge allows marks in the range 6 to 15 to be used as well as two rounds of voting1.
- Certificates can be allocated automatically to a chosen range of top marks.

Reports
- Reports for a log of loaded files, the blank scoresheet and results are now gathered in one place (File > Reports). Options allow the results report to be tailored to your needs.
- Results for a range of marks or for your own sequence constructed in the Lightbox can be produced.
- Statistics are added for the Results and Log reports.

Load Entries
- A competition status/log display is shown on the main form when a competition is selected. It is updated when images are loaded and colour coded items contain details of errors or warnings.

---
1 A triple judged competition has three judges who use a machine to each register a vote in the range 2 to 5. The total mark and whether there were any ‘5’ marks are recorded. For further selection of images there may be voting rounds where each judge awards a mark of ‘2’ for no vote and ‘5’ for a vote.
• Using semicolon as a separator in filenames is not allowed for some CD software. A fix has been made to allow underscore to be used automatically as an alternative where semicolon is expected.

• Loading now permits image title, author or club to be blank. Such cases are reported in the status/log display mentioned above and shown in blue to indicate a warning.

• Various common utility files such as ‘.Bridgesort’ are silently ignored when images are loaded to reduce clutter on the log.

• Where entrants have included a double extension such as ‘.jpg.jpg’ the surplus extension is removed from the image title.

Run Competition

• Pressing the F1 key during a competition will show the command and shortcut keys

• A set of projector setup screens can now be shown to check for geometry, focus, shadow and highlight detail as well as brightness and colour

• When resuming a competition, a single dialogue deals with all options rather than using several dialogues as before.

• Gold, Silver, Bronze and Ribbon awards have been added (in addition to Winner and Certificate).

• Award badges now are hidden when the image details are hidden rather than being permanently displayed over the image.

• An option allows the held back indicator to be either a coloured border (colour is selectable) or the word ‘Held’ instead of a mark.

• If the mouse is moved to the bottom of the screen, thumbnails of the currently held back images are shown. Moving the cursor out of this area causes the display to disappear. Clicking on any image shows it full size when it can be marked. Marked images are automatically removed from the held back display.

• The context menu allows full size viewing of all held back images without having to go into the Navigator.

• For triple judged competitions the ‘.’ key is used to record ‘at least one 5’.

• For triple judged competitions you can select Marks mode for initial marking or one of two votes modes to record first and second round votes for final selection.

Navigator

• Minor re-design of the interface to reduce the number of drop-downs for normal competitions and ones involving ‘placed’ marking. Only relevant items are displayed.

• Extra selectors are shown for triple judged competitions to allow selection of images meeting various criteria for marks, ‘5’s, and votes.

• New features in the Navigator and Light box can be used to select exhibition images from the entries².

Light box

• Thumbnails include marks, votes, medals, and flags to indicate held back, ‘5’s, plus marks and acceptances.

• Selected images can be added to or removed from the Exhibition Acceptances.

Scoresheet

• Scoresheet settings can now be made before the competition starts so that you can control the information reported on screen.

• The scoresheet can also include statistics of marks distributions and the total number of images held back.

² In some cases a certain number of the best competition images need to be selected for an exhibition.
Export and Import

- It is now possible to export and import Preferences from one machine to another so that a competition can be configured on, say, a desktop machine before exporting to the one for running the competition.

Preferences

- There is a choice between text or border type indication of held back images and the colour of the border and the held back flag in the Light box can be changed.
- A preference allows image details to be displayed before the image if you find the standard mode distracting.
- If you are using an image size narrower than the full width of your projector’s screen, an option allows it to be placed to the left, right or centre of the screen area. This may allow you to avoid a dead projector pixel.

Known Issues and Limitations

The following are known limitations.

Rules

- All rules are stored in the current computer user’s workspace. Thus, another user with a different account on the computer cannot see the rules and competitions of the first user. Workaround: You can use Export and Import to move rules and competitions between users.
- As a safety precaution DiCentra removes any loaded entries if you attempt to change rules for that competition. It does this even if the rule changes only affect scoring aspects.
- You must specify a folder in the rules. If an entrant fails to provide a folder on a CD or USB memory stick DiCentra will accommodate this and ask for the entrant name. Otherwise, you will need to create a folder with the entrant’s name on disk and copy the images there before loading.
- There are limited options at present for Portfolio competitions. For example, the folder name of each portfolio must be of the form: ‘Portfolio name; Author name’ and only straight marking schemes are allowed.

Load Entry

- No check is made that number of entries per person for inter-club competitions is within limits.
- Image number 0 is not allowed – this limitation will not be removed.
- When loading from CD, the dialogue box to select the folder can appear to have two identical entries for the CD and any image folder within it does not show. This is a Windows problem and if you cancel the dialogue and click Load again it should then work correctly.

Manual

- Please let us know of anything that is confusing or of any omissions.

Steve Wilbur
6\textsuperscript{th} March 2013